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8 Camtasia Studio

Camtasia Studio Gruppenprojekte

Camtasia Studio 7 & Gruppenprojekte

Camtasia Studio 7 eignet sich ideal fir die gemeinsame Arbeit an Videoprojekten.
Bk Camtasia-Projekte (CAMPRQOJ) kdnnen zu einer Zip-Datei komprimiert und an andere Mitarbeiter
verteilt werden.

B Die Bibliothek in Camtasia Editor erlaubt die Weitergabe von Medienelementen, sodass die
Konsistenz auf allen Videos sichergestellt ist.

B Ein schneller Upload zu Screencast.com ermdoglicht es lhnen, Ihre Videos mit anderen
auszutauschen und gegenseitig zu Gberprufen.

e Willkommen
Cmisa o7 Camtasia Studio 7

In den folgenden Abschnitten erfahren Sie, wie Sie in Gruppenprojekten zusammenarbeiten kénnen:

B  Tipps zum Verwalten von Videogruppenprojekten
Erstellen eines Videoskripts

Importieren mportieren eines gezippten Camtasia-Projekts
Projekte automatisch sichern (Autom. Speichern)
Exportieren eines Camtasia-Projekts als Zip-Datei fiir die Weitergabe
Bearbeiten der Abmessungen: Wie grof3 wird das Video?
Das Clip-Auswahlfenster

Die Bibliothek

Mediendateien in die Bibliothek importieren

Verwalten des Bibliotheksinhalts

Erstellen von Bibliothekselementen

Bibliothek als Zip-Datei (.LIBZIP) exportieren

Gezippte Bibliotheksdatei (.LIBZIP) importieren
Videoformat
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Tipps zum Verwalten von Videogruppenprojekten

Definieren Sie den Projektinhalt

Der erste Schritt in jedem Videoprojekt ist die Definition des Projektinhaltes. Das schliel3t auch die
Ausarbeitung der einzelnen Ziele und eine klare Bestimmung des Verwendungszwecks des Videos ein.

Wenn das Projekt dies erfordert, sollten sie auch recherchieren und Daten sammeln, die Ihre Ziele
unterstitzen.

Definieren Sie die Zielgruppe

Ist die Zielgruppe mit den im Video préasentierten Begriffen und Konzepten vertraut? Ist es erforderlich,
ein separates Einfihrungsvideo anzufertigen? Ist der Zweck des Videos Motivation, Marketing oder
Schulung?

Zusammenstellen der Projektgruppe

Organisieren Sie eine Besprechung mit allen, die an dem Videoprojekt beteiligt sind, und legen Sie die
Aufgabenverteilung fest. Wer wird das Skript schreiben, und wer den Text aufsprechen? Wer ist fir
Aufnahme, Redaktion und Fachlektorat zustandig?

Erst die Organisation, dann die Ausfiihrung

Erstellen Sie fur jedes Videoprojekt einen eigenen Ordner. Wéhrend der Arbeit am Projekt stellen Sie
dann alle Aufnahmen, Projektdateien, produzierten Videos und Mediendateien in diesen Ordner.

Sie sollten sich auch friihzeitig dartiber im Klaren sein, wo die Inhalte spater zur Verfligung gestellt
werden und mit welchem Backupverfahren sie gesichert werden. Screencast.com ist der ideale Ort fur
Upload, Speicherung und Schutz von Dateien und Videos. Und wenn erst die Bewertungsphase fiir ein
Video erreicht ist, kbnnen die Zuschauer tber die Kommentarfunktion von Screencast.com ihr Feedback
hinterlassen.

Brainstorming auf Papier

Grol3e Post-its in WandgroRe oder WeiBwandtafeln sind gute Mdglichkeiten, um ein Brainstorming im
Team durchzuftihren und Ideen zur Konzeption des Videos zu sammeln. Damit lassen sich auch die
Anféange des Videokommentars gut zusammentragen und organisieren.

Wenn Sie vor dem Beginn der eigentlichen Arbeit ein Brainstorming durchfihren, kann jeder der
Mitverantwortlichen sich einbringen und mitentscheiden, wie das Video aufgebaut wird.

Bestatigen Sie das Zeitschema fir das Projekt

Wann muss das Video fertig sein? Wahrend der Entwickelungsphase des Videos haben Sie zwar die
Mdglichkeit, den einzelnen Teammitgliedern verschiedene Aufgaben zuzuweisen, aber die Abgabefristen
stehen normalerweise fest. Denken Sie auch daran, Ihre Urlaubstage und die lhrer Teammitglieder in das
Zeitschema einzuplanen.

www.techsmith.de 3
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Erstellen Sie ein ausflihrliches Skript

Ein gutes Skript ist mehr als nur ein Kommentartext — es beschreibt auch, was parallel zum Kommentar
auf dem Bildschirm passiert. Erst Uber diese Details kdnnen Sie sich vorstellen, wie Aktionen auf dem
Bildschirm, der zeitliche Ablauf und Ubergangseffekte zusammenwirken und feststellen, wo noch
Leerrdume sind.

Mit ,Leerraum” bezeichnet man Teile des Kommentars, die von keiner Bildschirmaktivitat begleitet werden.
Bereiche mit Leerraumen sorgen haufig dafur, dass die Zuschauer das Interesse an einem Video
verlieren.

Erstellen Sie ein Video-Storyboard

Ein Storyboard ist eine Methode, das Video zu skizzieren. Ein gutes Storyboard zeigt, wo
Ubergangseffekte, Callouts, Titelclips, Zooms und andere Effekte gesetzt werden. Manche Leute
kombinieren Skript und Storyboard zu einem einzigen Dokument.

Bestimmen Sie die Details des Videos

Wie lange wird das Video dauern? Wird es Untertitel geben? Wie wird das Video weitergegeben oder
fur Mehrere nutzbar gemacht? Werden Corporate-Branding-Elemente wie Firmenembleme, Farben,
usw. eingesetzt?

Speichern Sie die Videoaufnahme als Camtasia-Aufnahmedatei (.camrec)

Fur Aufnahmen in Camtasia Studio stehen zwei Dateiformate zur Verfligung: ..camrec und .avi.
StandardmaRig werden Bildschirmaufnahmen als .camrec-Datei gespeichert.

Das Dateiformat .camrec ist ein angepasster Datei-Container der mehr Daten als nur eine Videodatei
enthdlt. .camrec-Dateien kénnen von anderen Videobearbeitungsprogrammen nicht gelesen oder
bearbeitet werden. Die in der .camrec-Datei gespeicherten Daten ermdglichen es, das Video nach dem
Ende der Aufnahme in Camtasia Studio zu bearbeiten.

Die .camrec-Datei kann folgende Daten enthalten:

@ AVI-Bildschirmaufnahme

Webcam-Video zur Verwendung als Picture-in-Picture (PIP)
Cursordaten

SmartFocus Zoom & Schwenk-Keyframe-Daten
Tastaturbefehl-Daten

Audiodaten von einem Mikrofon

Systemaudiodaten

Markierungsdaten

Speichern Sie Ihre Arbeit als Camtasia Studio-Projektdatei (CAMPROJ)

Wenn Sie Ihr Video bearbeiten, wird es in der Standardeinstellung als Camtasia-Projektdatei
(Dateiendung camproj) gespeichert. Ein Projekt wird automatisch angelegt, wenn Sie den Editor 6ffnen
oder nach der Aufnahme die Option Speichern und bearbeiten wéahlen.

In einer Camtasia Studio-Projektdatei werden alle Medien im Clip-Auswahlfenster und in der Bibliothek,
alle Clips und Effekte in der Timeline sowie Anderungen an der Timeline und die
Bearbeitungsabmessungen gespeichert.

Mit einer CAMPROJ-Datei kdnnen Sie:

#  Die Bearbeitung des Videos zu einem spéateren Zeitpunkt fortsetzen.

# Die camproj-Datei an andere Teammitglieder weitergeben, mit denen Sie gemeinsam an dem Video
arbeiten. Oder Ihr Projekt im komprimierten ZIP-Format speichern, um es an einen anderen Computer
zu Ubermitteln.

#  Das Video in einer Vielzahl verbreiteter Videoformate produzieren und weitergeben.
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Verwenden Sie die Bibliothek in Camtasia Editor

Die Medien in der Bibliothek sind dafiir konzipiert, in mehreren Projekten eingesetzt zu werden. Hier
sollten Sie Elemente mit Team- oder Markenrelevanz speichern, z. B. Titelclips, Callouts, usw.

Sie kdnnen eine Elementdatei, einen Ordner mit Elementen oder die gesamte Bibliothek als Zip-Datei
exportieren, die dann von anderen Mitarbeitern in deren eigene Bibliothek importiert werden kénnen.

Legen Sie eine Feedbackmethode fest

Wenn Sie Feedback einholen, ist es immer am besten, den Prifern gleich Ihre bevorzugte
Feedbackmethode mitzuteilen sowie den Zeitrahmen, in dem das Feedback erfolgen sollte. Hier einige
der Feedbackmethoden, die wir bei TechSmith einsetzen:

» Die integrierten Bewertungs- und Uberarbeitungstools in Microsoft Word oder Adobe Acrobat

Jing fur Feedback zu Grafiken und Videos

Snagit fur Bildschirmaufnahmen (Captures) und Anmerkungen

Screencast.com fir das Hosting von Videos zu Bewertungszwecken. Mit der Kommentarfunktion von
Screencast.com kdnnen die Zuschauer ihr Feedback abgeben

¥y ¥V ¥

Holen Sie Feedback in einem frihen Projektstadium ein

Wenn Sie andere um Feedback bitten, sollten Sie genau beschreiben, nach was Sie suchen. Benétigen
Sie ein Fachlektorat zu dem im Video gezeigten Verfahren? Soll die Stimme beurteilt werden, die fur den
Kommentar verwendet wird? Oder soll das Feedback ausdriicken, in wie fern das Video die gesteckten
Ziele erfullt?

B Versenden Sie bereits Skript und Storyboard, um eine frilhe Bewertung einzuholen, sodass Sie das
Feedback bereits in diesem Stadium beriicksichtigen kdnnen. Zwar wird dies durchaus Zeit in
Anspruch nehmen, die Mihe wird aber am Ende durch ein besseres Video belohnt.

B Wenn Sie mit der Zusammenstellung des Videos beginnen, sollten Sie schon friihzeitig eine
Demoversion oder einen Prototyp des Videos erstellen, und diese Version zwecks Feedback an lhre
Teamkollegen oder andere Mitverantwortliche senden.

#  Es empfiehlt sich auch, mit Leuten, die fir Ihr Zielpublikum représentativ sind, Tests durchzufiihren
und dadurch sicherzustellen, dass lhre Ziele erfillt werden.

Sorgen Sie fur einen guten Informationsfluss

Informieren Sie alle Projektverantwortlichen Uber die jeweiligen Fortschritte. Informieren Sie sie Uber
erfolgreich abgeschlossene Meilensteine, aber auch tGber Probleme und Anderungen, sobald sie auftreten.

Informieren Sie Ihr gesamtes Team. Werden Anderungen in Betracht gezogen, sollten Sie das Ihr Team
baldmdglichst wissen lassen. Und stellen Sie sicher, dass jeder im Team weil3, was der andere tut.

www.techsmith.de 5
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Erstellen eines Videoskripts

Ein gutes Skript ist mehr als ein Kommentartext — es beschreibt auch, was parallel zum Kommentar auf
dem Bildschirm passiert.

Wenn Sie neben dem Kommentar auch Videoaktionen ins Skript schreiben:

# Bekommen Sie selbst und andere eine Vorstellung davon, wie die Aktionen auf dem Bildschirm, der
Kommentar und der zeitliche Ablauf zusammenwirken.

B Sind Szenenwechsel bereits gekennzeichnet.

#  Werden vorhandene Leerrdume offengelegt. Mit ,Leerraum” bezeichnet man Teile des Kommentars,
die von keiner Bildschirmaktivitéat begleitet werden. Bereiche mit Leerrdumen sorgen haufig dafir,
dass die Zuschauer das Interesse an einem Video verlieren.

Sie sollten es auch in Betracht ziehen, die Szenen in Ihrem Video anhand eines Storyboards zu
skizzieren. Ein gutes Storyboard zeigt, wo Ubergangseffekte, Callouts, Titelclips, Zooms und andere
Effekte gesetzt werden. Manche Leute kombinieren Skript und Storyboard zu einem einzigen Dokument.

Fahren Sie mit dem Abschnitt Tipps fir ein gutes Skript auf der nachsten Seite fort.

Diese Spalte enthalt

Details zum Ablauf mit Diese Spalte enthélt den
Text- und Bildelementen. gesprochenen Kommentar.
N Tor : . . Benutzen Sie
A Tec ith Getting Started / Intro VidepCamtasia Studio — EN Formatierung, um
7 Show how to access the project again. But, the video only plays the first time you open Camtasia Studio her\.-'orzuhebe!n
To open the sample project in the future, choose File > Recent projects welche Worte betont
select Getting Started. Werden So"en
NOtleren Sle: wo If you would like to skip this video and begin using Camtasia Studio 7 rightaway,TT
eine neue Szene click File > New Project or click the Record the screen button, s
- +START TIMELINE HERE 50, let’s start with the Timeline — this is where you assemble and edit your .
kbeglnnt. I videss. Verwenden S_le
9. | Zoomin ontickmarks At the top of the timeline you'll see tick marks representing time in ter Gedankenstriche (') oder
| minutes and seconds. EIIlpsen( ) um Pausen
Flgen Sie Grafiken zu kennzeichnen.
oder Zeichnungen ein
" + . g ' rawing callout arrow to the right. When building a video on the timeline, you'll work in a horizontal manner,
Un’;gu | u;'lréerer-?: was beginning from the left and moving sequentially through time toward t Formulleren Sle kUrZ
aur dem oldscnhirm ‘s
. und blndig.
passiert.
QOder 2eoen Sie den th lider i ti Use the Zo pion t ify th of the timeli di Y Pro Zeile sollten Sie
-~ " H e zoom slider in operation. se the Zoom option to magnify the view e timeline and increase
Callout-Typ, Titelclip distance between the tick marks. emen Gedanken oder
oder Ubergangseffekt, Thlshe\pswheﬂaﬂ:ﬂngslnceltIetsyoumakemorepreclsecutsandsel eine Aktion erklaren.
der benutzt werden soll./ I <

Drucken Sie sich klar und deutlich aus; formulieren
Sie so wie Sie auch sprechen wirden.

Erlauben Sie dem Sprecher, den Text an den
eigenen Sprechrhythmus und Tonfall anzupassen.

www.techsmith.de 6



= Camtasia Studio

Camtasia Studio Gruppenprojekte

Tipps fur ein gutes Skript

Verwenden Sie natlrliche Formulierungen

Der Sprachstil in Videos mit Bildschirmaufnahmen ist in der Regel lassiger und nattrlicher als der formelle
Stil, der in technischen Dokumentationen verwendet wird. Bei der Vorbereitung lhres Skripts sollten Sie
Formulierungen vermeiden, die zu férmlich oder zu ,gestelzt* klingen.

Kurz und bundig

Schreiben Sie kurze, pragnante Satze. Jede Zeile in einem Dokument oder in einer Tabelle sollte eine
bestimmte Aktion oder einen Gedanken reprasentieren.

Kennzeichnen Sie Betonungen und Pausen

Zeichnen Sie betonte Worter fett oder kursiv aus. Verwenden Sie im gesamten Skript einheitliche
Auszeichnungen, und teilen Sie dem Sprecher mit, welche Formatierung was bedeutet.

R&aumen Sie im Skript Pausen ein, die den nattrlichen Sprachfluss oder einen Bildschrimwechsel oder
einen Dialog zwischen zwei Sprechern widerspiegeln. Kennzeichnen Sie eine Pause im Skript durch
einen Gedankenstrich () oder eine Ellipse (...).

Sorgen Sie fur leichte Lesbarkeit

Verwenden Sie eine grol3e, gut leserliche Schrift sowohl fiir Onlineskripte als auch fir Ausdrucke. Arial
oder Verdana, 12 oder 14 Punkt sind gut geeignet.

Unbedingt Korrektur lesen

Ein gutes, sauberes Skript liest sich besser. Daher sollten Sie die Rechtschreibung tberprifen und
grundlegende Stilfragen redigieren. Auch Anleitungen und Navigationsanweisungen sollten Sie von zwei
verschiedenen Personen Korrektur lesen lassen.

Prifung & Abstimmung

Senden Sie lhr Skript zur Prifung an andere Mitarbeiter, auch zur fachlichen Abstimmung. Wundern Sie
sich nicht, wenn Sie lhr Skript mehrfach Uberarbeiten und verbessern missen — es ist durchaus méglich,
dass diese Phase die zeitaufwendigste des gesamten Videoprojekts sein wird.

Geben Sie dem Sprecher das Skript bereits ein paar Tage vor dem Aufnahmetermin, damit er sich
einlesen und den Text vorbereiten kann. Rechnen Sie auch damit, dass Sie das Skript noch etwas
anpassen muissen, sodass es in der Sprechweise des Sprechers natirlich und wie in einem echten
Gesprach klingt.

www.techsmith.de 7
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Skript laut lesen und die Zeit stoppen

Achten Sie beim Lautlesen auf den Textfluss, sodass Ihnen Zungenbrecher und schwer auszusprechende
Wortkombinationen gleich auffallen.

Camtasia Studio Gruppenprojekte

B Stoppen Sie die Zeit, die Sie beim Lautlesen bendtigen, damit Sie eine ungeféhre Vorstellung
bekommen, wie lange das Video dauern wird. Videos von Bildschirmaufzeichnungen sollten eine
Lange von etwa 3 bis 5 Minuten haben.

B Wenn ein Dialog zwischen zwei oder mehr Leuten darin vorkommt, sollten die verschiedenen Rollen
von mehreren Leuten gesprochen werden.

#  Wenn irgend mdglich, sollten Sie das Skript lesen und gleichzeitig die Aktionen auf dem Bildschirm
ausfuhren, um eine genauere Vorstellung von der Lange des Videos zu bekommen.

Uben Sie das Umschlagen der Seite

Wird das Skript vom Papier abgelesen, stellen Sie sicher, dass die Seiten nummeriert sind, und nicht auf
einem Stapel liegen. Lassen Sie den Sprecher die seitenweise Navigation durch das Skript tiben.
Dadurch lassen sich Gerausche verhindern, die durch Blattern oder Herumstébern im Papier entstehen
koénnten, und in der Audioaufnahme zu héren waren.

www.techsmith.de 8
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Die Camtasia Studio-Projektdatei

Wenn Sie Ihr Video bearbeiten, wird es in der Standardeinstellung als Camtasia-Projektdatei
(Dateiendung camproj) gespeichert. Ein Projekt wird automatisch angelegt, wenn Sie den Editor 6ffnen
oder nach der Aufnahme die Option Speichern und bearbeiten wéahlen.

In einer Camtasia Studio-Projektdatei (Dateiendung camproj) werden alle Medien im Clip-Auswahlfenster
und in der Bibliothek, alle Clips und Effekte in der Timeline sowie Anderungen an der Timeline und die
Bearbeitungsabmessungen gespeichert.

Mit camproj-Dateien kénnen Sie:

#  Die Bearbeitung des Videos zu einem spéateren Zeitpunkt fortsetzen.

# Die camproj-Datei an andere Teammitglieder weitergeben, mit denen Sie gemeinsam an dem
Video arbeiten.

B lhr Projekt im komprimierten ZIP-Format speichern, um es an einen anderen Computer zu Ubermitteln.
# Das Video in einer Vielzahl verbreiteter Videoformate produzieren und weitergeben.

So erstellen Sie ein Camtasia Studio-Projekt

1. Beginnen Sie ein neues Projekt. Wahlen Sie dazu eine der folgenden Mdoglichkeiten:
@ Klicken Sie in Camtasia Editor auf Datei > Neues Projekt.

@ Wahlen Sie nach dem Aufnehmen mit Camtasia Recorder im Vorschaufenster die Option
Speichern und bearbeiten.

@  Wahlen Sie nach dem Aufnehmen mit dem PowerPoint Add-In im Dialogfeld Nach dem Speichern
- Optionen die Option Aufnahme bearbeiten.

2. Um weitere Medien hinzuzuftigen, wéhlen Sie Medium importieren &7 Medien importieren .

3. Arrangieren Sie die Clips und Elemente auf der Timeline.
4. Speichern Sie die Camtasia Studio-Projektdatei (.camproj).

Siehe auch:

B Importieren mportieren eines gezippten Camtasia-Projekts
B  Projekte automatisch sichern (Autom. Speichern)
B Exportieren eines Camtasia-Projekts als Zip-Datei fir die Weitergabe

www.techsmith.de 9
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Importieren mportieren eines gezippten Camtasia-Projekts

Beim Import einer gezippten Projektdatei wird diese von Camtasia Studio in einen von lhnen gewahlten
Ordner entpackt. AnschlieRend kann das Projekt mit Camtasia Studio gedffnet werden.
1. Klicken Sie in Camtasia Studio auf Datei > Gezippte Projektdatei importieren.

2. Das Dialogfeld Gezippte Projektdatei importieren wird angezeigt. Klicken Sie auf Durchsuchen, und
wahlen Sie eine gezippte Projektdatei aus.

3. Wahlen Sie einen Projektordner aus.

4. Aktivieren Sie die Option Projekt nach Import 6ffnen, damit Ihr Projekt in Camtasia Studio gedffnet
wird.

5. Kilicken Sie auf OK.

Siehe auch:

#  Projekte automatisch sichern (Autom. Speichern)
B Exportieren eines Camtasia-Projekts als Zip-Datei fir die Weitergabe
B So erstellen Sie ein Camtasia Studio-Projekt

Projekte automatisch sichern (Autom. Speichern)

Beim automatischen Speichern wird automatisch eine Backup-Projektdatei zu Datensicherungszwecken
gespeichert. Die Option ,Autom. Speichern” ist standardmafiig aktiviert.

Andern des Zeitabstands fiir die automatische Speicherfunktion

1. Wahlen Sie in Camtasia Studio Tools > Optionen > Registerkarte ,, Programm®.
2. Aktivieren Sie die Option Autom. Speichern.

3. Geben Sie im Feld Intervall fir autom. Speichern an, nach wie vielen Minuten jeweils gespeichert
werden soll.

4. Klicken Sie auf OK.

.
Optionen h_ M

Programm| PowerPoint I Upgrade-Cptionen I Zoom I Tastenkombinah’onen|

[¥] AVI-Dateien Uber Camtasia Player wiedergeben

[¥] Dialogfeld 'Willkommen' beim Start anzeigen

[¥] Quiz-Platzhalter anzeigen

[¥] Dizlogfeld 'PIP-Vorschau' anzeigen

[¥] Beim Hinzufiigen von Markisrungen zu Texteingabe auffordern
Autom, Speichern }

[¥] Autom. Speichern aktivieren

Intervall fiir autom, 10 = Minute(n)

Wenn Sie das Projekt nach einem Absturz oder Systemfehler 6ffnen, stellt Camtasia Studio automatisch
die zuletzt gespeicherte Projektdatei wieder her.

Siehe auch:

B Importieren mportieren eines gezippten Camtasia-Projekts
B Exportieren eines Camtasia-Projekts als Zip-Datei fir die Weitergabe
B So erstellen Sie ein Camtasia Studio-Projekt

www.techsmith.de 10
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Exportieren eines Camtasia-Projekts als Zip-Datei fur die
Weitergabe

Mithilfe der Option Projekt als Zip exportieren kénnen Sie eine Zip-Datei erstellen, um ein Projekt an
einen neuen Speicherort innerhalb des Netzwerks zu Ubertragen, eine Kopie der Projektdateien zu
sichern oder die Projektdatei schnell an Mitarbeiter zu senden.

V' Wenn Originaldateien, die Gber das Clip-Auswahlfenster importiert wurden, auf der Festplatte oder im
Netzwerk geldscht oder verschoben werden, kann dies Ihre Camtasia Studio-Projekte beschadigen.
Bevor Sie Dateien verschieben oder I6schen, miissen Sie lhre Videoprojekte 6ffnen und als gezippte
Camtasia Studio-Projektdatei exportieren.

Achten Sie darauf, dass beim Exportieren die Option Alle Dateien aus Clip-Auswahlfenster zu ZIP
hinzufiigen markiert wird. Hierdurch werden die Dateien im Clip-Auswahlfenster in der ZIP-Datei
gesichert, sodass das Projekt mit allen Ressourcen eigenstandig lauffahig ist.

" N

Projekt als Zip Exportieren_L

Mame der neuen ZIP-Datei:

Alle Dateien aus Clip-Auswahlfenster zu ZIP hinzufiigen

ok || Abbrechen || Hife |

Eine Zip-Datei eines Projektes erstellen

1. Klicken Sie in Camtasia Studio auf Datei > Projekt als Zip exportieren.

2. Das Dialogfeld Projekt als Zip exportieren wird angezeigt. Klicken Sie auf Durchsuchen, um einen
Speicherort auszuwahlen. Klicken Sie auf Speichern.

3. Aktivieren Sie die Option Alle Dateien aus Clip-Auswahlfenster zu ZIP hinzufiigen, um eine Kopie
aller Dateien, die sich derzeit im Clip-Auswabhlfenster befinden, in diese zip-Datei aufzunehmen.

4. Kilicken Sie auf OK.

Siehe auch:

B Importieren mportieren eines gezippten Camtasia-Projekts
#  Projekte automatisch sichern (Autom. Speichern)
B So erstellen Sie ein Camtasia Studio-Projekt

www.techsmith.de 11
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Bearbeiten der Abmessungen: Wie grol3 wird das
Video?

[;] Ansicht > Projekt > Bearbeitungsabmessungen

Das Dialogfeld Bearbeitungsabmessungen wird angezeigt, wenn Sie der Timeline das erste Mal einen
Clip hinzufiigen. Fir Vollbildaufnahmen oder Aufnahmen, die mit Standard- oder Widescreen-Profil
angefertigt wurden, kann die Standardeinstellung ibernommen werden.

Wenn Sie mit anderen Abmessungen arbeiten méchten, wahlen Sie im Dropdown-Menu die
Abmessungen aus, die das fertig produzierte Video haben wird.

[ L_J Bearbeitungsabmessungen ﬁw 540 % 480
Welches Format sol das Video haben? 600 x 450 Automatisch
Wahlen Sie die Abmessungen, die beim Weitergeben des 1280 %1024 Aufnahmeformate
bearbeiteten und produzierten Videos verwendet 640 x 480 Zuletzt verwendet
werden solien. 640 x 480 Benutzerdefiniert
Abmessunge Widescreen (16:9)  Empfchlen far
540 x 480 - l 640 x 360 Blog, Internet
/ 800 x 450 Screencast.com
Breite: &40 I} I 1280720 YouTube & HD
Hihe: 430 Seitenverhaltnis beibehalten Standard (4:3) Empfohlen far
480 x 360 Blackberry
640 x 480 Internet
ok || dbrechen | [ nire | 800 % 600 Vollbildanzeige
— = Andere Empfohlen fir
480 x 320 (3:2) iPhone/iPod Touch
720 480 (3:2) DVD-kempatibel (NT5C)
720 576 (5:4) DVD-kompatibel (PAL)

Abmessungsprofile

Ein Profil enthalt verbreitete Produktionseinstellungen, die fir die vorgesehene Verbreitungsform optimiert
sind: Blog, CD, DVD-kompatibel, HD, iPhone, iPod, Screencast.com, Internet oder YouTube. Wéahlen Sie
ein Profil aus, um vorab zu sehen, wie Ihr fertiges Video mit den gewéahlten Abmessungen aussehen wird.

Benutzerdefinierte Abmessungen
# Um die Breite und Hohe der Bearbeitungsabmessungen individuell festzulegen, geben Sie die
gewlinschten Abmessungen (in Pixeln) in die Felder Breite und Héhe ein.

#  Um die urspriinglichen Abmessungen des Clips beizubehalten, wahlen Sie die Option
Aufnahmeformate.

‘; Um die besten Ergebnisse mit den Optionen Benutzerdefiniert oder Aufnahmeformate in den
Projekteinstellungen zu erzielen, wéahlen Sie im Produktions-Assistenten die
Option Benutzerdefinierte Produktionseinstellungen.

www.techsmith.de 12
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Das Clip-Auswahlfenster

Das Clip-Auswabhlfenster enthalt Verweise auf alle Video-, Audio- und Bildclips, die in das aktuelle Projekt
importiert wurden. Sie kénnen der Timeline mehrere Instanzen eines Clips hinzuftgen.

‘} Clips im Clip-Auswabhlfenster werden durch Bearbeitungen auf der Timeline nicht gedndert. Wenn Sie
der Timeline einen Clip hinzufligen, wird dabei eine Kopie des Ausgangs-Clips erstellt. Wenn Sie also
beispielsweise einen Clip auf der Timeline teilen, wird der zugehdrige Original-Clip im Clip-
Auswabhlfenster nicht geteilt.

V' Wenn Originaldateien, die Gber das Clip-Auswahlfenster importiert wurden, auf der Festplatte oder im
Netzwerk geldscht oder verschoben werden, kann dies Ihre Camtasia Studio-Projekte beschadigen.
Bevor Sie Dateien verschieben oder I6schen, miissen Sie lhre Videoprojekte 6ffnen und als gezippte
Camtasia Studio-Projektdatei exportieren.

Achten Sie darauf, dass beim Exportieren die Option Alle Dateien aus Clip-Auswahlfenster zu ZIP
hinzufiigen markiert wird. Hierdurch werden die Dateien im Clip-Auswahlfenster in der ZIP-Datei
gesichert, sodass das Projekt mit allen Ressourcen eigensténdig lauffahig ist.

" N

Projekt als Zip Expcrtieren_-‘_

Mame der neuen ZIP-Datei:

Alle Dateien aus Clip-Auswahlfenster zu ZIP hinzufiigen

ok || Abbrechen || Hife |

Ein produziertes Video enthalt nur die Clips und Elemente auf der Timeline.

B Wenn Sie dem Video einen Clip hinzufigen mdchten, ziehen Sie ihn aus dem Clip-Auswabhlfenster
auf die Timeline, oder klicken Sie mit der rechten Maustaste darauf und wahlen Sie Zur Timeline
hinzuftigen.

B Ziehen Sie einen Audioclip aus dem Clip-Auswabhlfenster in die Spuren Audio 1, Audio 2, Audio 3
oder PIP-Audio. Sie kdnnen statt dessen auch mit der rechten Maustaste auf einen Audioclip klicken
und eine der folgenden Optionen wahlen: Zum Track hinzufligen > Audio 1, Audio 2, Audio 3 oder
PIP-Audio.

www.techsmith.de 13
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Datei

Bearbeiten  Ansicht

Wiedergabe Te Hilfe

“ Bildschirm aufnehmen - [&J Medien importieren  ¥& Produzieren und weitergeben = =

Camtasia-Aufnahmedatei

ApplyTornEdge.ca.. audio-enhance-z..  AutePan.camrec

Clip- Bibliothek
Auswahlfenster

w7 O L-V:,h.
.

Spuren ¥

== = — =

#  Um Clips oder Medien, die nicht auf der Timeline verwendet werden, aus dem Clip-Auswabhlfenster zu
entfernen, klicken Sie mit der rechten Maustaste in das Clip-Auswabhlfenster und wahlen im
Kontextmenii die Option Nicht verwendete Clips entfernen.
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Mediendateien in das Clip-Auswahlfenster importieren
Camtasia Studio fugt importierte Mediendateien ins Clip-Auswahlfenster hinzu.
Sie kdnnen die folgenden Mediendateien in eine Camtasia Studio-Projektdatei (.camproj) importieren:

#  Videodateien (..camrec, .avi, .mp4, .mpg, .mpeg, .wmv, .mov, .swf)

‘} Mehrspurigkeit in mov-Dateien wird von Camtasia Studio nicht unterstitzt. Camtasia Studio
importiert eine Video- und eine Audiospur aus mov-Dateien.

; .swf-Dateien kdnnen nur importiert werden, wenn sie mit Jing oder Camtasia Studio erstellt
wurden.

# Bilddateien (BMP, GIF, JPG, PNG)
B Audiodateien (WAV, MP3, WMA)
B+  Gezippte Projektdateien

v Wenn Originaldateien, die Uber das Clip-Auswahlfenster importiert wurden, auf der Festplatte oder im
Netzwerk geldscht oder verschoben werden, kann dies Ihre Camtasia Studio-Projekte beschadigen.
Bevor Sie Dateien verschieben oder I6schen, miissen Sie lhre Videoprojekte ¢ffnen und als gezippte
Camtasia Studio-Projektdatei exportieren.

Achten Sie darauf, dass beim Exportieren die Option Alle Dateien aus Clip-Auswahlfenster zu ZIP
hinzufiigen markiert wird. Hierdurch werden die Dateien im Clip-Auswahlfenster in der ZIP-Datei
gesichert, sodass das Projekt mit allen Ressourcen eigenstandig lauffahig ist.

Projekt als Zip exportieren ‘.‘

MName der neuen ZIP-Datei:

Alle Dateien aus Clip-Auswahlfenster zu ZIP hinzufigen

ok | [ bbrechen |[ Hire |

Mediendateien in das Clip-Auswahlfenster importieren

1. Wahlen Sie in Camtasia Studio den Tab ,Clip-Auswahlfenster".

2. Waéhlen Sie die Option Medien importieren 7 Medien importieren .

3. Wahlen Sie die Datei(en) fur den Import aus. Halten Sie die <STRG>-Taste gedriickt, um mehrere
Dateien auszuwahlen.

4. Klicken Sie auf Offnen. Die Medien werden im Clip-Auswahlfenster angezeigt.

‘} Wenn Sie dem Video einen Clip hinzufiigen mdchten, ziehen Sie ihn aus dem Clip-
Auswabhlfenster auf die Timeline, oder klicken Sie mit der rechten Maustaste darauf und wahlen
Sie Zur Timeline hinzufiugen.

Siehe auch:

Bearbeiten der Abmessungen

Das Clip-Auswahlfenster

Die Bibliothek

Mediendateien in die Bibliothek importieren
Verwalten des Bibliotheksinhalts

Bibliothek als Zip-Datei (.LIBZIP) exportieren
Gezippte Bibliotheksdatei (.LIBZIP) importieren

¥V ¥V VvV VvV V¥
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Die Bibliothek

Die Bibliothek enthélt Timeline-Sequenzen, Callouts, Titelclips, Videos, Audiodateien, Bilder und and
andere Elemente, die in mehreren Projekten verwendet werden sollen. Die in der Bibliothek verwalteten
Objekte werden als Medienelemente bezeichnet.

Camtasia Studio Gruppenprojekte

B Wenn Sie eine bestimmte Sequenz am Anfang oder am Ende aller lhrer Videos verwenden méchten,
erstellen Sie diese einmal, und speichern sie in der Bibliothek. Von hier kdnnen Sie sie in andere
Videoprojekte tibernehmen.

#  Wenn Ihr Unternehmen Standardelemente (Callouts, Titelclips oder Ubergangseffekte) in seinen
Videos verwendet, fiigen Sie diese Elemente in die Bibliothek ein, exportieren sie und geben sie
an alle Mitglieder Ihres Teams weiter.

Die Bibliothek enthélt bereits bei der Installation Medienelemente, die Sie benutzen kénnen, um
beispielsweise professionelle Intros, Schlusssequenzen oder Titelclips fur Ihre Videos zu erstellen.

B Wenn Sie dem Video ein Medienelement hinzufligen mdchten, ziehen Sie es aus der Bibliothek auf
die Timeline, oder klicken Sie mit der rechten Maustaste darauf und wahlen Sie Zur Timeline
hinzufugen.

B Ziehen Sie ein Audioelement aus der Bibliothek in die Spuren Audio 1, Audio 2, Audio 3 oder PIP-
Audio. Sie kénnen statt dessen auch mit der rechten Maustaste auf ein Audioelement klicken und
eine der folgenden Optionen wahlen: Zum Track hinzufiigen > Audio 1, Audio 2, Audio 3 oder PIP-
Audio.

Datei Bearbeiten Ansicht Wiedergabe Tools Hilfe

* Bildschirm aufnehmen ~ [&J Medien importieren  ¥& Produzieren und weitergeben ~ =

MName Typ Grobe
Audic Folder il
=] Digital Radius Folder
Digital Radius Lower Third Callout 3 KB
Digital Radius Arrow Callout 4 KB E
| Digital Radius Title Title Clip 10 KE
\j Digital Radius Intro Sequence 13 KB - o= ny,
| Digital Radius Background Bild T3 KB N
\j Digital Radius Animation Video 4,594 KB \
Fiber Waves Folder ‘
Mew Folder Folder l
Rounded Angles Folder '
Sibver Streak Folder '

digital radius mp4

Text Callo
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Medien-Eigenschaften in der Bibliothek anzeigen

Um zusatzliche Eigenschaften wie Dateiname, Speicherort oder Dateigrof3e anzuzeigen, klicken Sie mit
der rechten Maustaste auf ein Bibliothekselement, und wahlen Sie im Kontextmeni die Option

Eigenschaften.

Medienelemente in der Bibliothek sortieren

Medienelemente in der Bibliothek kénnen nach Name, Typ oder DateigréRRe sortiert werden. Um die
Sortierkriterien zu &ndern, klicken Sie mit der rechten Maustaste auf die Bibliothek und wéhlen Sie im
Kontextmenu die Option Sortieren nach. Sie kénnen statt dessen auch auf eine Sortieroption am oberen

Rand des Bibliotheksfensters klicken.

Bildschirm aufnehmen ~ &3 Medien importieren

& Produzieren und

Mame
Audio I}

Fiber Waves

Mew Folder

3]

Rounded Angles
Silver Streak

3]

Typ
Folder

Digital Radius Folder

Folder
Folder
Folder
Folder

Grofe

Siehe auch:

# Mediendateien in die Bibliothek importieren
Verwalten des Bibliotheksinhalts

Erstellen von Bibliothekselemente

Bibliothek als Zip-Datei (.LIBZIP) exportieren
Gezippte Bibliotheksdatei (.LIBZIP) importieren

¥V ¥V V¥
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Mediendateien in die Bibliothek importieren

Folgende Dateiformate kénnen in die Bibliothek importiert werden:

#  Videodateien (..camrec, .avi, .mp4, .mpg, .mpeg, .wmv, .mov, .Swf)

A’ Mehrspurigkeit in mov-Dateien wird von Camtasia Studio nicht unterstitzt. Camtasia Studio
importiert eine Video- und eine Audiospur aus mov-Dateien.

A’ .swf-Dateien kdnnen nur importiert werden, wenn sie mit Jing oder Camtasia Studio erstellt
wurden.

# Bilddateien (BMP, GIF, JPG, PNG)
B Audiodateien (WAV, MP3, WMA)
B  Gezippte Bibliothek

1. Wabhlen Sie in Camtasia Studio den Tab ,Bibliothek”.

2. Wahlen Sie die Option Medien importieren &7 Medien importieren |

3. Wahlen Sie die Datei(en) fur den Import aus. Halten Sie die <STRG>-Taste gedriickt, um mehrere
Dateien auszuwahlen.

4. Klicken Sie auf Offnen. Das Element wird in der Bibliothek angezeigt.

} Um ein Element zum hinzuzufiigen, ziehen Sie es aus der Bibliothek auf die Timeline, oder
klicken Sie mit der rechten Maustaste darauf und wahlen Sie Zur Timeline hinzufiigen.

Wie sollen Elemente zur Bibliothek hinzugefiigt werden?

Elemente kénnen entweder als physische Dateikopien oder als Verknipfungen zu der betreffenden
Originaldatei in die Bibliothek tlbernommen werden.

Um das Standardverfahren fur das Hinzufigen von Elementen festzulegen, wéhlen Sie Tools >
Optionen > Registerkarte Programm > Bereich Inhalte der Bibliothek.

Die Optionen werden nachstehend erlautert.

Optionen _ &J

Programm |P0werPoint I Upgrade-Optionen | Zoom | Tastenkombinationen|

AVI-Dateien (ber Camtasia Flayer wiedergeben

R AR o SN L

Inhalte der Bibliothek Standarddauer (Sekunden)
() Inhalt in Bibliothek kopieren Uberganagseffekte: 3,0

- Bilder: 5.0
’ Bibliothek bereinigen

Callouts: 5,0

EY LI RN S

Hilfe
Alle Tipps anzeigen
Alle Sprechbl, -Tipps anzeigen Produktionsvorschauen: 30

Titeldips: 5,0

Allw| (4]

Temporarer Speicherordner

Ci\Wserstkam110\AppData'Local Templ

ok || Abbrechen || Hife |
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Inhalte in Bibliothek kopieren

Camtasia Studio Gruppenprojekte

Diese Option bewirkt, dass jedes Element als Kopie in die Bibliothek ibernommen wird. Kopierte
Elemente vergroRern den Umfang von Camtasia Studio-Projektdateien. Deshalb sollten nur Elemente in
die Bibliothek kopiert werden, die zur Verwendung in mehreren Projekten vorgesehen sind. Fir
Mediendateien, die nur im aktuellen Projekt benétigt werden, verwenden Sie statt dessen das Clip-
Auswabhlfenster.

B Wenn Sie eine Timeline-Auswahl (auch als Timeline-Sequenz bezeichnet) als kopiertes Element zur
Bibliothek hinzuftigen, wird nicht nur der ausgewahlte Teil, sondern das gesamte Video in die
Bibliothek kopiert. Dies vergroRert den Umfang lhrer Camtasia Studio-Projektdateien. Deshalb sollten
Timeline-Sequenzen moglichst nicht als Kopie, sondern als Verknipfung zur Bibliothek hinzugefiigt
werden.

V' Das Léschen von Elementen in der Bibliothek kann dazu fuhren, dass Projekte, in denen diese
Elemente vorkommen, nicht mehr verwendbar sind. Auch das Verschieben oder Léschen von
Dateien, die in die Bibliothek importiert wurden, kann die Verwendbarkeit lhrer Camtasia Studio-
Projekte beeintrachtigen. Bevor Sie Dateien verschieben oder l6schen, missen Sie Ihre
Videoprojekte 6ffnen und als gezippte Camtasia Studio-Projektdatei exportieren.

Achten Sie darauf, dass beim Exportieren die Option Alle Dateien aus Clip-Auswahlfenster zu ZIP
hinzufiigen markiert wird. Hierdurch werden die Dateien im Clip-Auswahlfenster in der ZIP-Datei
gesichert, sodass das Projekt mit allen Ressourcen eigenstandig lauffahig ist.

" N

Projekt als Zip Expcrtieren_-h_

Mame der neuen ZIP-Datei:

Alle Dateien aus Clip-Auswahlfenster zu ZIP hinzufiigen

ok || Abbrechen || Hife |
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Inhalt verlinken

Camtasia Studio Gruppenprojekte

Wenn diese Option aktiv ist, wird in der Bibliothek eine Verkniipfung zu der auf der lokalen Festplatte oder
im Netzwerk gespeicherten Originaldatei des Elements angelegt. Die Verknupfung ist nur giiltig, solange
die Originaldatei an ihrem urspriinglichen Speicherort vorhanden ist. Deshalb sollten die Elementdateien
an einem Ort gespeichert sein, an dem sie nicht verschoben oder versehentlich geléscht werden kdnnen.

B Das Loschen von Elementen in der Bibliothek kann dazu fiihren, dass Projekte, in denen diese
Elemente vorkommen, nicht mehr verwendbar sind. Bevor Sie Elemente 16schen, 6ffnen Sie alle
Projekte und exportieren Sie diese als gezippte Dateien. Hierdurch werden die Bibliothekselemente in
der ZIP-Datei gesichert, sodass das Projekt mit allen Ressourcen eigensténdig lauffahig ist.

B Um ein verknipftes Element in ein als Kopie abgelegtes Element umzuwandeln, klicken Sie mit der
rechten Maustaste auf das Element in der Bibliothek, und wahlen Sie im Kontextmeni die Option
~Eigenschaften”.

Sequence 2010-03-09 113645 Eigenschaften | 3

Eigenschaften
[LibraryT\Sequence_2010-03-09_113645
Type: Timeline-5equenz
Size: 7595 KB
Dimensions: 640 x 480
Duration: 0:00:02;16
Created: 05.03.2010 11:36:45
Creator: KAM110

Verkniipfung mit Bibliothek

In Bibliothek kopieren ]

V' Das Loschen von Elementen in der Bibliothek kann dazu fuhren, dass Projekte, in denen diese
Elemente vorkommen, nicht mehr verwendbar sind. Auch das Verschieben oder Loschen von
Dateien, die in die Bibliothek importiert wurden, kann die Verwendbarkeit lhrer Camtasia Studio-
Projekte beeintrachtigen. Bevor Sie Dateien verschieben oder l6schen, missen Sie Ihre
Videoprojekte 6ffnen und als gezippte Camtasia Studio-Projektdatei exportieren.

Achten Sie darauf, dass beim Exportieren die Option Alle Dateien aus Clip-Auswahlfenster zu ZIP
hinzufiigen markiert wird. Hierdurch werden die Dateien im Clip-Auswahlfenster in der ZIP-Datei
gesichert, sodass das Projekt mit allen Ressourcen eigensténdig lauffahig ist.

-' =

Projekt als Zip Exportieren_-‘

Mame der neuen ZIP-Datei:

Alle Dateien aus Clip-Auswahlfenster zu ZIP hinzufigen

ok || Abbrechen || Hife |

Siehe auch:

B+ Die Bibliothek

Verwalten des Bibliotheksinhalts

Erstellen von Bibliothekselemente

Bibliothek als Zip-Datei (.LIBZIP) exportieren
Gezippte Bibliotheksdatei (.LIBZIP) importieren

¥V ¥V V¥
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Verwalten des Bibliotheksinhalts

Camtasia Studio bietet eine Reihe von Optionen zur Verwaltung der Elemente in der Bibliothek.

Camtasia Studio Gruppenprojekte

Bibliothekselement umbenennen

Um ein Element in der Bibliothek umzubenennen, klicken Sie darauf, warten Sie kurz und klicken Sie
dann noch einmal. Der Name wird nun markiert. Geben Sie den neuen Namen ein.

Ordner erstellen
Ordner erleichtern die Verwaltung der Bibliothek.

Um einen Ordner zu erstellen, klicken Sie mit der rechten Maustaste in den Tab ,Bibliothek”. Wahlen Sie
im Kontextmeni den Befehl Neuer Ordner, und geben Sie einen Namen fiir den Ordner ein.

mportieren..,

Meuer Ordner

Gezippte Bibliothek importieren...

Medium anline abrufen...

Sortieren nach

Elemente zu einem Ordner hinzufigen

Um ein Element zu einem Ordner hinzuzuftigen, klicken Sie darauf, ziehen Sie es mit gedriickter
Maustaste auf den Ordner und lassen Sie die Maustaste los.

;’ In Bibliotheksordnern kdnnen keine Unterordner angelegt werden.
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Element aus der Bibliothek |6schen

Um ein Element oder einen Ordner aus der Bibliothek zu lI6schen, klicken Sie mit der rechten Maustaste
darauf und wéhlen Sie im Kontextmeni den Befehl Aus Bibliothek entfernen. Sie werden aufgefordert,
den Léschvorgang zu bestatigen.

Camtasia Studio Gruppenprojekte

4 Das Léschen von Elementen in der Bibliothek kann dazu fuhren, dass Projekte, in denen diese
Elemente vorkommen, nicht mehr verwendbar sind. Auch das Verschieben oder Léschen von
Dateien, die in die Bibliothek importiert wurden, kann die Verwendbarkeit lhrer Camtasia Studio-
Projekte beeintrachtigen. Bevor Sie Dateien verschieben oder l6schen, missen Sie Ihre
Videoprojekte 6ffnen und als gezippte Camtasia Studio-Projektdatei exportieren.

Achten Sie darauf, dass beim Exportieren die Option Alle Dateien aus Clip-Auswabhlfenster zu ZIP
hinzufiigen markiert wird. Hierdurch werden die Dateien im Clip-Auswahlfenster in der ZIP-Datei
gesichert, sodass das Projekt mit allen Ressourcen eigenstandig lauffahig ist.

A
Projekt als Zip ExpurtiereEL ﬁ

Mame der neuen ZIP-Datei:
amtasia Studio\Getting Started.zo |l =

Alle Dateien aus Clip-Auswahlfenster zu ZIP hinzufiigen

ok || Abbrechen || Hife |

Bibliotheksordner I6schen

Um einen Ordner zu l6schen, klicken Sie mit der rechten Maustaste darauf und wahlen Sie im
Kontextmeni den Befehl Aus Bibliothek entfernen. Sie werden aufgefordert, den Loschvorgang zu
bestatigen.

4 Das Loschen eines Bibliotheksordners, der Elemente enthélt, kann dazu fuhren, dass Projekte, in
denen diese Elemente vorkommen, nicht mehr verwendbar sind. Auch das Verschieben oder
Ldschen von Dateien, die in die Bibliothek importiert wurden, kann die Verwendbarkeit lhrer Camtasia
Studio-Projekte beeintrdchtigen. Bevor Sie Dateien verschieben oder I16schen, missen Sie lhre
Videoprojekte 6ffnen und als gezippte Camtasia Studio-Projektdatei exportieren.

Achten Sie darauf, dass beim Exportieren die Option Alle Dateien aus Clip-Auswahlfenster zu ZIP
hinzufiigen markiert wird. Hierdurch werden die Dateien im Clip-Auswahlfenster in der ZIP-Datei
gesichert, sodass das Projekt mit allen Ressourcen eigensténdig lauffahig ist.

A
Projekt als Zip ExportiereEL ﬁ

Mame der neuen ZIP-Datei:
amtasia Studio\Getting Started.zD ]l I

Alle Dateien aus Clip-Auswahlfenster zu ZIP hinzufiigen

ok || Abbrechen || Hife |
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Bereinigen der Bibliothek

Die Option Bibliothek bereinigen entfernt ungiltige Verkntpfungen aus der Bibliothek, indiziert die
Inhalte neu und aktualisiert die Ordner.

Wenn Sie haufig Elemente zur Bibliothek hinzufiigen, daraus I6schen und darin verschieben, sollten Sie
diese Option als Wartungsmaflinahme regelmaRig ausfihren.

Siehe auch Bibliothek als Zip-Datei (.LIBZIP) exportieren.

'} Nachdem die Bibliothek bereinigt wurde, lasst sich die friihere Version nicht wiederherstellen.

Siehe auch:

# Die Bibliothek

Mediendateien in die Bibliothek importieren
Erstellen von Bibliothekselemente

Bibliothek als Zip-Datei (.LIBZIP) exportieren
Gezippte Bibliotheksdatei (.LIBZIP) importieren

vV ¥V V¥
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Erstellen von Bibliothekselementen

Bibliothekselemente kdnnen aus Inhalten auf der Timeline erstellt werden. Timeline-Sequenzen kdénnen
Markierungen, Zoom & Schwenk-Keyframes, Videodaten, Audiodaten, Callouts und weitere Objekte
enthalten.

B Wenn Sie eine bestimmte Sequenz am Anfang oder am Ende aller lhrer Videos verwenden méchten,
erstellen Sie diese einmal und speichern sie in der Bibliothek. Von hier kbnnen Sie sie in andere
Videoprojekte tibernehmen.

#  Wenn Ihr Unternehmen Standardelemente (Callouts, Titelclips oder Ubergangseffekte) in seinen
Videos verwendet, fliigen Sie diese Elemente in die Bibliothek ein, exportieren sie und geben sie
an alle Mitglieder Ihres Teams weiter.

‘} Wenn eine Timeline-Sequenz ausgewahlt und in der Bibliothek gespeichert wird, wird nicht nur der
ausgewabhlte Bereich, sondern das vollstéandige Video gespeichert. Wenn die Sequenz auf die
Timeline gezogen wird, wird dort nur der ausgewahlte Bereich angezeigt.

Timeline-Sequenz hinzuflgen

1. Markieren Sie einen Bereich auf der Timeline. Oder wahlen Sie einen Video- oder Audioclip oder ein
anderes Element (Callouts, Zoom-Keyframes usw.) aus.

2. Klicken Sie mit der rechten Maustaste auf die Auswabhl.

3. Wahlen Sie im Kontextmenii den Befehl In Bibliothek speichern.

A o L Callante 1 o
Bibliothek Callouts Auswahl prodizieren ak... Mehr

Auswahlfenster

PRI . Ausschneiden Ctrl+X

Kopieren Ctrl+C

- o
== oSpuren ¥ 0 Einfiigen Ctrl+V

Teilen 5

Auf Auswahl ruschneiden

In Bibliothek speichern...
Audio bearbeiten..,

4. Die Sequenz wird als Element zur Bibliothek hinzugefugt.
B Um das Element in der Bibliothek umzubenennen, klicken Sie darauf.

B Um die Bibliotheksinhalte zu strukturieren, ziehen Sie das Element mit der Maus in einen
passenden Ordner.

@ Um das Element Ihrem fertigen Video hinzuzufligen, ziehen Sie es auf die Timeline.
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So fugen Sie einen Video- oder Audioclip zur Bibliothek hinzu:

1. Markieren Sie den Clip auf der Timeline, indem Sie darauf klicken. Ein ausgewahlter Clip ist blau
unterlegt.

2. Klicken Sie mit der rechten Maustaste auf den Clip.
3. Waéhlen Sie im Kontextmenii den Befehl In Bibliothek speichern.
4. Der Clip wird als Element zur Bibliothek hinzugefiigt.
@ Um das Element in der Bibliothek umzubenennen, klicken Sie darauf.

B Um die Bibliotheksinhalte zu strukturieren, ziehen Sie das Element mit der Maus in einen
passenden Ordner.

@  Um das Element Ihrem fertigen Video hinzuzufligen, ziehen Sie es auf die Timeline.

Timeline-Elemente hinzuflgen
So fligen Sie Elemente wie einen Zoom & Schwenk-Keyframe oder ein Callout zur Bibliothek hinzu:

1. Klicken Sie mit der rechten Maustaste auf das Element auf der Timeline.
2. Wahlen Sie im Kontextmenii den Befehl In Bibliothek speichern.

In Bibliothek speichern...

Audio bearbeiten...

Wikt e o L

3. Der Clip wird als Element zur Bibliothek hinzugefugt.
B Um das Element in der Bibliothek umzubenennen, klicken Sie darauf.

B Um die Bibliotheksinhalte zu strukturieren, ziehen Sie das Element mit der Maus in einen
passenden Ordner.

@ Um das Element Ihrem fertigen Video hinzuzufligen, ziehen Sie es auf die Timeline.

Siehe auch:

# Die Bibliothek

Mediendateien in die Bibliothek importieren
Verwalten des Bibliotheksinhalts

Bibliothek als Zip-Datei (.LIBZIP) exportieren
Gezippte Bibliotheksdatei (.LIBZIP) importieren

¥y ¥V VvV V¥V
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Bibliothek als Zip-Datei (.LIBZIP) exportieren

Wenn lhr Unternehmen bestimmte Elemente (Callouts, Titelclips oder Ubergangseffekte) in seinen Videos
verwendet, erstellen Sie diese Elemente einmal und flgen sie in die Bibliothek ein. Exportieren Sie
anschlieRend die Bibliothek als Zip-Datei (.libzip), um sie an Mitglieder Ihres Teams weiterzugeben.

Sie kdnnen einen oder mehrere Ordner oder die gesamte Bibliothek exportieren.

So exportieren Sie Bibliothekselemente oder die gesamte Bibliothek als
Zip-Datei

1.

Fuhren Sie in der Bibliothek folgende Schritte durch:

@ Klicken Sie auf eine Elementdatei oder einen Ordner.
- oder -

@ Wenn Sie mehrere Dateien oder Ordner auswéhlen méchten: Halten Sie die Taste <Strg>
gedrickt und klicken Sie wahrenddessen nacheinander auf die gewinschten Dateien/Ordner.

- oder -

@ Wenn Sie die gesamte Bibliothek exportieren mdchten: Wéahlen Sie keine Dateien aus.

2. Kilicken Sie mit der rechten Maustaste auf eines der markierten Elemente, und wéhlen Sie im
Kontextmenu den Befehl Exportieren.
@ Um die gesamte Bibliothek zu exportieren, klicken Sie mit der rechten Maustaste auf ein nicht
markiertes Element, und wahlen Sie im Kontextmeni den Befehl Exportieren.
= Silver Streak Folder
- Silver Streak Animation . 2204 KB
- - Zur Timeline hinzufigen
Silver Streak Arrow -
[ _|Silver Streak Background forschau
- e e s Aus Bibliothek entfernen
Sihver Streak Lower Third EfpanTEEr
[~ IR Umbenennen
Sound Effects Eigenschaften...
Target Blue Folder
3. Ubernehmen Sie den vorgegebenen Speicherort und Dateinamen, oder klicken Sie auf Durchsuchen,
um einen anderen Speicherort bzw. Dateinamen festzulegen. Klicken Sie auf OK.
g M
Bibliothek als Zip exportieren l ﬁ
Mame der neuen ZIP-Datei:
CiYJsersikam 110'Documents\Camtasia StudioiLibPkg_2010-0: =
| ok | [ abbrechen | | mife |
Siehe auch:
B+ Die Bibliothek
# Mediendateien in die Bibliothek importieren
B+ Verwalten des Bibliotheksinhalts
# Erstellen von Bibliothekselemente
B  Gezippte Bibliotheksdatei (.LIBZIP) importieren
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Gezippte Bibliotheksdatei (.LIBZIP) importieren

Sie kdnnen Medienelemente zu lhrer Bibliothek hinzufligen, indem Sie eine gezippte Bibliotheksdatei
(libzip) importieren.

Aus dem Editor importieren

1. Wahlen Sie im Editor von Camtasia Studio den Menubefehl Datei > Bibliothek > Gezippte
Bibliothek importieren.

Produzieren - Spezial »

Medium importieren.., Strg+1
Zuletzt gedffnete Aufnahmen
Bibliothek J Medium importieren...

Gezippte Projektdatei importieren... Neuer Ordner

Beenden Exportieren...
Gezippte Bibliothek importieren...

Medium online abrufen... I:}

2. Das Dialogfeld Gezippte Bibliothek importieren wird angezeigt. Suchen Sie eine libzip-Datei und
wahlen Sie diese aus. Klicken Sie auf Offnen.

3. Kilicken Sie auf OK, um den Importvorgang zu starten.

Uber Windows Explorer importieren

1. Doppelklicken Sie in Windows Explorer auf eine libzip-Datei.
2. Ein Bestatigungsdialogfeld wird angezeigt. Klicken Sie auf Ja, um den Importvorgang zu starten.

i LibPkg_2010-03-09 140755.libzip {J

3

.
Camtasia Studic ﬁ

Siehe auch:

# Die Bibliothek

# Mediendateien in die Bibliothek importieren

#  Verwalten des Bibliotheksinhalts

B Erstellen von Bibliothekselemente

# Bibliothek als Zip-Datei (.LIBZIP) exportieren

Bk  Gezippte Bibliotheksdatei (.LIBZIP) importieren
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Videoformate

Die folgende Liste unterstutzt Sie bei der Entscheidung, welches Videoformat und welcher Dateityp fur
Ihre Zielgruppe geeignet ist.

Dateityp

Dateierweit

Weitergabe

Starken

Schwachen

sowie in den meisten
nichtlinearen
Bearbeitungsprogram
men bearbeiten.

Umfasst hochwertige
Audiooptionen.

erung
Macromedia | SWF/FLV Einbettung in Lasst sich in 95 % der Benotigt das Macromedia
Flash IMPEG4 eine Webseite. meisten Browser Flash-Plug-In, das
ohne zusétzliche gewdhnlich
Software abspielen. standardmé&Rig installiert
Plattformiibergreifend wird.
Audio Video | AVI CD-ROM, Weit verbreitet und Vor dem Laden muss
Interleave Netzwerkverzeic einfach abzuspielen. erst die gesamte Datei
und CD- hnis oder von Bearbeitbar und leicht auf den Computer
Produktionen einer Website in andere Filmformate heruntergeladen werden.
heruntergeladen konvertierbar. Die Audiokomprimierung
Ein hervorragendes ist nicht so gut wie bei
anbieterneutrales Streaming-Formaten.
Format fur Ihren TSCC-codiertes AVI
Filmmaterialbestand benétigt den TSCC-
oder zur Weitergabe Video-Codec fir die
auf CD-ROM. Wiedergabe. TSCC ist
jetzt in den Camtasia
Player integriert.
TSCC kann richtige
Fotoaufnahmen oder
Farbverlaufe nicht
komprimieren.
Audio Video | AVI DVD Die bestmdgliche Bendtigt eine DVD-
Interleave Aufnahmequalitat. Authoring-Software, um
und DVD- Lasst sich in es in das MPEG-Format
Produktionen Camtasia Studio zu konvertieren.

Umfangreiche
Dateigrof3e moglich mit
bewegungsintensiveren
und komplexen
Bildaufzeichnungen.

Vor dem Laden muss
erst die gesamte Datei
auf den Computer
heruntergeladen werden.

TSCC kann richtige
Fotoaufnahmen oder
Farbverlaufe nicht
komprimieren.
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Dateityp

Dateierweit
erung

Weitergabe

Starken

Schwéchen

RealPlayer
(RealPlayer-
Plug-In)

von einer
Website.

Videokomprimierung
und verlustfreies
Streaming.

Streaming-Dateien
Uber niedrige
Bandbreite, aul3er bei
Real-World- oder
bewegungsintensiven
Videos.

Windows WMV Ubermittlung per Eignet sich gut fur Benotigt einen
Media (WMV Streaming oder langere oder Streaming-Server mit
- Streaming- direktes bewegungsintensiver Internet-Zugang, damit
Format) Abspielen von e Aufnahmen. es von einer Website
der Festplatte. Kleine DateigroRe abgespielt werden kann.
Wird nicht auf den Der Computer, der das
Computer Video abspielt, benttigt
Wird beim eine Internet-Verbindung.
Herunterladen gleich Eingeschrénkte
abgespielt. Bearbeitungsoptionen.
Lasst sich in Microsoft Kann nicht in ein anderes
) ; Format konvertiert
Windows Media
. werden.
Player und in
Browsern abspielen.
QuickTime MOV Per Streaming Grol3e Auswahl an Bei langsamen
von einer Video- und Downloads kann es zu
Website oder als Audiokompressoren. ruckartigen
Anhang in einer Wird beim Bildbewegungen
E-Mail. Herunterladen gleich kommen.
abgespielt. Die gesamte Datei wird
Plattformiibergreifend, auf den Computer des
Industriestandard, Zuschauers
Multimedia- heruntergeladen.
Softwarearchitektur. Bendtigt Apple
QuickTime.
RealMedia- RM Per Streaming Kleine DateigréRe Bendotigt einen
Streamingme von einer Lasst sich nicht auf Streaming-Server, damit
dien Website. den Computer es von einer Website
herunterladen. gestreamt werden kann.
Wird in RealPlayer Verluste bei der
und in Browsern mit Videokomprimierung.
Hervorragende Bearbeitungsoptionen
Audiokomprimierung Lasst sich nicht in ein
anderes Format
konvertieren.
Camtasia fur | CAMV Per Streaming Verlustfreie Lasst sich nur schwer als

E-Mail-Anhang
versenden, da Audio und
Video Uber eine SMIL-
Datei verbunden sind.

Benotigt einen
Streaming-Server.

Es muss RealPlayer
installiert sein, und es
muss eine Internet-
Verbindung bestehen.

www.techsmith.de

29




& Camtasia Studio

Camtasia Studio Gruppenprojekte

Dateityp Dateierweit Weitergabe

erung

Starken

Schwachen

GIF- GIF Einbettung in
Animationsda beliebige

tei Webseite. Lasst
sich in fast
jedem Browser
abspielen.

Wird von nahezu allen
Webbrowsern
unterstitzt. Sind
tendenziell kleiner als
andere
Animationsdateien.

Animierte GIF-
Dateien sind auf
Webseiten recht
verbreitet. Dank ihrer
kleinen GroR3e eignen
sie sich ideal fir eine
Bereitstellung Uber
das Web, wenn die
Detailtreue von AVI-
Dateien nicht
erforderlich ist.

Animierte GIF-
Dateien sind stark
komprimiert.

Dieses Dateiformat
nach Industrienorm
ermd@glicht lhnen die
Veroffentlichung
kurzer Anleitungen
und
Produktdemonstration
en Ubers Web. Sie
lassen sich in jedem
Browser und auf jeder
Computerplattform
abspielen.

B Unterstitzt kein Audio.

B st auf 256 Farben
beschrankt.

B Weniger Vielfalt und
Flexibilitat.

# Ist auf kurze Animationen
beschrankt.

Pack and EXE Als E-Mail-
Show Anhang oder
Einbettung in
eine Webseite.

Einfache
Verfuigbarkeit der
Filme fir die
Zuschauer.

Konvertiert Camtasia-
Videos in eine
ausflihrbare Datei
(EXE). Die Benutzer
kdnnen Camtasia
Player installieren, um
die Videos
anzuschauen.

Erhalt eine hohe
Auflésung und
Qualitat.

Keine besondere
Software erforderlich.

Manche Leute haben aus
Sicherheitsgriinden ihre E-
Mail-Programme fur den
Empfang ausfihrbarer
Dateianhénge gesperrt.

Lange Ausfiihrungszeiten bei
umfangreichen Dateien.
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Mochten Sie ansprechende
Screencasts erstellen?

Wahrend der Entwicklungsphase von Camtasia Studio 7 wollte die Customer Engagement Group
herausfinden, was einen wirklich guten Screencast ausmacht — wie entsteht ein Video, das die
Aufmerksamkeit der Zuschauer bis zur letzten Sekunde fesselt? Was macht ein Video zum
Publikumserfolg?

Wir haben also Videoproduzenten und Leute, die Videos anschauen, eingeladen und eine
Fokusgruppenaktion durchgefiihrt, bei der sich alles um die Frage drehte:

Wodurch wird ein Screencast interessant, gut oder ansprechend?

Die Aktion wurde folgendermal3en durchgefihrt:

3. Jede Person erhielt einen schwarzen Filzstift und einen gro3en Stapel farbiger Haftnotizen.

4. Alle wurden gebeten, ihre Gedanken, Ideen, Schnellverfahren und Tipps & Tricks zu Papier zu
bringen — fur jeden Punkt eine eigene Notiz. Wé&hrend diesem Teil der Aktion gab es keine
Gruppendiskussionen. Es gab auch keine Richtig/Falsch-Antworten.

5. Jede Notiz wurde von ihrem Autor laut
vorgelesen und dann an die Wand geheftet.
Dabei entstand ein konstanter Fluss an
Leuten, die schrieben, lasen und anhefteten.
Dieser Prozess ebbte ab und schwoll wieder
an ohne irgendwelche formellen Regeln.

6. Nachdem alle Gedanken und Ideen
eingefangen waren, war es an der Zeit, die
Notizen in &hnliche Gruppen und Kategorien
zu sortieren. Jeder, der daran teilnehmen
wollte, konnte eine Sortierung vornehmen
und wahrenddessen die Griinde dafiir
erlautern. Es war moglich, dass mehrere
Leute bei der Sortierung
zusammenarbeiteten.

7. Die Notizen wurden sortiert, umsortiert und
wieder neu sortiert, wenn die Kategorien verfeinert wurden (die Gruppen oder Kategorien hatten
keine Namen — sie wurden nur durch das Gruppieren von Notizen definiert).

8. Nachdem die Sortierung und Gruppierung abgeschlossen war, erhielten sie von den
Fokusgruppenmitgliedern Namen.
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... Was haben wir daraus gelernt? Die Ergebnisse werden Sie Giberraschen!

Die Gruppe fand heraus, dass der gro3te Teil dessen, was ein ansprechendes Video ausmacht, schon
geschieht, bevor Sie auf irgendeine Aufnahme-Taste in Camtasia Studio klicken!

Dinge wie:
B Klare Ziele fur das Video setzen
Langsam sprechen

o
B Ein Skript fir den Kommentar erstellen
B Ein gutes Mikrofon verwenden, damit eine gute Tonqualitét entsteht

Der Rest der wichtigen Ratschlage hatte zu tun mit den Leitprinzipien der Bildschirmaufzeichnung und
einigen grundlegenden Bearbeitungsfunktionen in Camtasia Studio.

Wir dachten, dass Sie die verschiedenen Kategorien, die die Fokusgruppe erarbeitete, sowie deren
Gedanken, Ideen, Schnellverfahren und Tipps & Tricks zum Erstellen interessanter, guter und
ansprechender Screencasts, gern sehen wirden. Wir hoffen, Sie finden das ebenso interessant wie wir!

Gute Vorbereitung

1. Sie sollten Ihr Publikum kennen.
Ist die Zielgruppe mit den im Video préasentierten Begriffen und Konzepten vertraut? Ist es erforderlich,
ein separates Einfihrungsvideo anzufertigen?

2. Ist der Zweck des Videos Motivation, Schulung oder Verkauf?
Entscheiden Sie sich in lhrem Video fur einen dieser drei Punkte und versuchen Sie nicht, eine
Kombination von zwei oder drei dieser Punkte auf einen Schlag zu prasentieren. Erstellen Sie
geeignete Inhalte, die zur gewahlten Kategorie passen.

3. Studieren Sie andere Videos, um zu lernen, was diese ansprechend, interessant oder schlecht
macht.

4. Schreiben Sie ein Skript —improvisieren Sie nicht.
Ein gutes Skript enthalt den Kommentar und eine Beschreibung dessen, was parallel zum
Kommentar auf dem Bildschirm passiert. Das Befolgen eines Skripts hilft, ungewollte ,Ahhs* und
~-Hmms" im Tonmaterial zu vermeiden.

5. Erstellen Sie ein Storyboard lhres Videos.
Ein Storyboard ist eine Methode, das Video zu skizzieren. Sie sollten aufzeigen, wo Ubergéange,
Callouts, Zooms und andere Effekte vorkommen sollen.

6. Planen und entscheiden Sie rechtzeitig, was Sie aufnehmen werden .
Welche Anwendungen werden Sie einsetzen? Benétigen Sie Formulare, in denen bestimmte Felder
ausgefullt sind? Werden Sie Grafiken verwenden, die rechtzeitig vorher angefertigt werden miissen?
7. Es wird langer dauern als Sie es sich vorstellen.
Warten Sie also nicht bis zur letzten Minute, um Ihr Videoprojekt zu beginnen.

Verbessern Sie Ihre Vortragsweise
8. Machen Sie sich mit dem Thema lhres Videos vertraut.
Sie sollten so sprechen, dass Sie wirklich wie ein Experte klingen.

9. Sprechen Sie langsam und deutlich, und befolgen Sie das Skript.
Schweifen Sie nicht vom Thema ab und denken Sie nicht, Sie mussten die ganze Zeit reden.

10. Zeigen Sie sich so, wie Sie sind.
Lassen Sie lhre Personlichkeit durchscheinen — setzen Sie lThren Humor ein, wenn es zu der Situation
passt.

11. Sprechen Sie naturlich.
12. Uben Sie, das Skript laut zu sprechen.
13. Horen Sie lhre aufgenommene Stimme an, und gewdhnen Sie sich daran, sich selbst zu horen.
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Filmografie

14. Machen Sie sich mit den Fachbegriffen und Konzepten der Bildschirmaufzeichnung vertraut.
Lesen Sie sich ein bisschen ein in die Themen, Videodateiformate, Screencasting, usw.

15. Viel aufnehmen, wenig produzieren.
Der Camtasia Recorder nimmt SmartFocus-Zoom-Keyframes automatisch auf. Wenn Sie auf
kleineren Geréten, wie etwa einem iPod, verdffentlichen, werden Zoom-Keyframes automatisch
hinzugefiigt, damit sich die Aktion Ihres Videos weiterhin in der Bildschirmmitte abspielt.

16. Erzéhlen Sie eine Geschichte.
Was nehmen Sie auf und warum ist es wichtig?

17. Einfiuhrung und Zusammenfassung
Geben Sie eine Einfiihrung dessen, was Sie im Video zeigen, und schlieen Sie es mit einer
Zusammenfassung ab.

18. Lassen Sie das Video sprechen.
Sie mussen nicht jedes Detail ansprechen und jeden Schritt kommentieren. Zeigen Sie stattdessen
die Schritte, und sprechen Sie Uber die Wichtigkeit des Vorgangs oder Arbeitsablaufs, den Sie gerade
demonstrieren.

19. Halten Sie das Video in Fluss.
Verharren Sie nicht zu lange auf einer Stelle. Ihre Zuschauer kdnnten sonst das Interesse verlieren.

Lernen Sie die Grundlagen

20. Schauen Sie sich die Tutorialvideos an.
Das Lern Center von TechSmith im Web umfasst eine Vielzahl von Lehrvideos, die Sie bei der
Einarbeitung unterstitzen.

21. Lesen Sie die Hilfedatei.
Sie werden Tutorials und Lehrgange fur den gesamten Camtasia Studio-Leistungsumfang finden.

22. Spielen Sie mit den Beispielprojekten.
Laden Sie im Web die Beispielprojekte vom TechSmith Lern Center herunter. Die Beispielprojekte
zeigen lhnen, wie Sie eine Funktion anwenden, wahrend Sie die Aufgaben auf der Timeline
durchfiihren.

23. Uben, Uben, Uben!
Sie benétigen Ubung und Zeit, um die Grundlagen zu lernen und um herauszufinden, wie es fur Sie
am besten funktioniert. Stellen Sie sicher, dass Sie etwas Ubungszeit haben, bevor Ihr erstes Projekt
anberaumt ist.

24. Machen Sie mehrere Probedurchlaufe, um Ihr Skript und lhr Zeitschema zu testen.
Nehmen Sie nach Bedarf Anderungen und Anpassungen vor.

25. Haben Sie keine Angst, Fehler zu machen.
Legen Sie los, probieren Sie alles einfach aus. So lernen Sie am besten. Die unbegrenzten
Ruckgéngig- und Wiederherstellen-Schaltflachen auf der Timeline-Symbolleiste erlauben es lhnen,
Ihre Bearbeitungsfertigkeiten zu Gben oder neue Funktionen auszuprobieren.

26. Speichern Sie Ihre Arbeit haufig.

Projekte und Teamarbeit

27. Erst die Organisation, dann die Ausfiihrung.
@ Erstellen Sie fur jedes Videoprojekt einen eigenen Ordner. Wéhrend der Arbeit am Projekt stellen
Sie dann alle Aufnahmen, Projektdateien, produzierten Videos und Mediendateien in diesen
Ordner.
@ Wenn Sie einige Ihrer Mediendateien in mehreren Projekten einsetzen wollen, importieren Sie sie
in die Bibliothek — nicht in das Clip-Auswahlfenster.
28. Exportieren Sie Ilhr Camtasia-Projekt (CAMPROQJ) als Zip-Datei.
Mediendateien, die im Clip-Auswahlfenster von Camtasia Editor angezeigt werden, besitzen dort nur
eine Referenz. Wenn Sie also die Dateien vom urspriinglichen Speicherort verschieben, werden sie in
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29.

30.

Ihrem Videoprojekt fehlen. Beim Exportieren eines Camtasia Projekts als Zip-Datei wird ein
Sicherungsprojekt erstellt. Dieses enthéalt alle notwendigen Mediendateien, die in das Clip-
Auswahlfenster und die Bibliothek kopiert wurden. Sie kénnen das komprimierte Projekt auch an eine
Gruppe von Mitarbeitern weitergeben oder anhand der Zip-Datei das Projekt auf einen anderen
Computer ubertragen.

Fugen Sie Clips und andere Elemente in die Bibliothek ein, damit sie auch von anderen
Mitarbeitern genutzt werden kénnen.

Die Medien in der Bibliothek sind daftir konzipiert, in mehreren Projekten eingesetzt zu werden. Hier
sollten Sie Elemente mit Team- oder Markenrelevanz speichern, z. B. Titelclips, Callouts, usw. Stellen
Sie lhre Bibliothek anderen Mitarbeitern zur Verfugung, um fur Konsistenz zwischen den
verschiedenen Projekten zu sorgen.

Erstellen Sie schon frihzeitig eine Demoversion des Videos, und senden Sie sie an lhre
Teamkollegen oder andere Mitverantwortliche, um von diesen Feedback zu erhalten.

Der Schliissel dabei ist, dies in einem frihen Stadium des Prozesses zu machen, damit lhnen auch
die Zeit bleibt, das Feedback zu nutzen und Anderungen an lhrem Skript und Storyboard
vorzunehmen. Zwar wird dies durchaus Zeit in Anspruch nehmen, die Miihe wird aber am Ende durch
ein besseres Video belohnt.

Gute Audioqualitat

31.

32.

33.

34.

35.

36.

37.

38.

39.

Verwenden Sie das beste Mikrofon, das Sie sich leisten kénnen.
Der Sound ist bei Bildschirmaufnahmevideos wichtig. Videos mit schlechter Tonqualitat werden oft
nicht angeschaut.

Verwenden Sie die Standard-Audioeinstellungen von Camtasia Recorder.
Dazu gehort, dass Sie lhre Systemaudiodaten in einer separaten Spur aufzeichnen (diese Option ist
fur Benutzer des XP-Betriebssystems nicht verfligbar).

Machen Sie eine Testaufnahme, und stellen Sie dabei sicher, dass die Audiodaten
aufgenommen wurden.

Passen Sie die Lautstarke in Camtasia Editor an.
Ist der Ton zu laut oder zu leise, verwenden Sie die Lautstarkeregler in Camtasia Editor. Fligen Sie
Audiopunkte ein, um bestimmte Bereiche der Wellenform zu verbessern.

Hintergrundmusik richtig eingesetzt, kann ein nettes Extra sein.

Wenn Sie Hintergrundmusik abspielen, wéhrend Sie den Kommentar mit einem Mikrofon aufnehmen,
erscheint die Hintergrundmusik in Camtasia Editor auf einer separaten Spur. Bearbeiten Sie die
Hintergrundmusik so, dass sie zum Kommentar passt, indem Sie Ein- oder Ausblendeffekte
verwenden oder die Lautstarke anpassen.

Zeichnen Sie die Audio- und Videodaten separat auf.

Wenn Sie mit der Anwendung von Camtasia Studio vertraut sind, versuchen Sie den Bildschirm ohne
die Audiodaten aufzunehmen. Nehmen Sie alle erforderlichen Anderungen in Camtasia Editor vor. Ist
die Videobearbeitung abgeschlossen, figen Sie mithilfe der Option ,,Gesprochener Kommentar” die
Audiodaten hinzu. So machen das erfahrungsgeman die Videoexperten.

Halten Sie inne, und hdren Sie sich den Sound in Ihrem Aufnahmebereich an.

Nehmen Sie Ihren Bildschirm mit Audiodaten auf, aber sprechen Sie nicht. Héren Sie sich dann die
Aufnahme an. Sie werden sich wundern, wie viele Gerdusche in einem Zimmer vorhanden sind.
Knarrt oder quietscht Ihr Stuhl? Hat das Telefon geklingelt? Wie laut ist die Tastatur beim Schreiben?
Sind Haustiere oder Kinder im Hintergrund? Lauft ein Heizungs- und Kihlungslufter, den man héren
kann? Nimmt das Mikro ein Summen vom Computer oder von anderen Geraten auf?

Nehmen Sie in einer ruhigen Umgebung auf.

Nehmen Sie lhre Audiodaten moglichst nicht an einem 6ffentlichen Platz auf. Gehen Sie in einen
Buro- oder Konferenzraum, der nicht an eine verkehrsreiche StraRe grenzt. Hangen Sie einen Zettel
an die Tur, auf dem Sie anderen mitteilen, dass Sie gerade aufnehmen.

Verwenden Sie die Optionen im Tab , Audio” von Camtasia Editor, um die Audiodaten
aufzuwerten.

Reduzieren Sie Gerdusche, gleichen Sie den Lautstarkepegel aus, und entfernen Sie Weil3rauschen,
,Ahhs* und ,Hmms",
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40. Raumen Sie zunéachst den Desktop auf.
Am besten nehmen Sie einen Desktop mit einfachem Hintergrund auf, der nicht zu viele
Desktopsymbole und Spielereien enthalt.

41. Deaktivieren Sie alle Erinnerungen oder sonstigen Pop-Up-Fenster.
Deaktivieren Sie alle Erinnerungen an Besprechungen, E-Mail-Benachrichtigungen oder sonstigen
Pop-Up-Fenster.

42. Uberprifen Sie ihr Internetbrowserfenster.
Haben Sie unnétige Symbolleisten getffnet? Wenn ja, deaktivieren Sie sie bzw. blenden Sie sie aus.
Verraten lhre Lesezeichen und die Verlaufsanzeige zu viel Perstnliches?

43. Offnen Sie die Anwendungen, die Sie aufnehmen werden, und schlieRen Sie alle anderen.
Manchmal dauert es etwas, bis ein Anwendungsfenster geoffnet ist, und es gibt nichts Schlimmeres
als ein Video anzuschauen, das zeigt, wie eine Anwendung gedffnet wird. Wenn es nicht wichtig ist,
das Starten einer Anwendung zu zeigen, halten Sie alle Anwendungen bereit, und verwenden Sie
<ALT + TAB>, um die verschiedenen Anwendungen anzuzeigen. Und schlie3en Sie alle
Anwendungen und Fenster, die Sie nicht benétigen, z. B. E-Mails, Browserfenster, usw.

44. Andern Sie die GroRe der Fenster, sodass sie dem Aufnahmebereich entsprechen.
Camtasia Recorder zeichnet nur lhren primaren Monitor auf. Wenn Sie also zu einer Anwendung
wechseln, stellen Sie sicher, dass sie im ausgewahlten Aufnahmebereich angezeigt wird.

45. Machen Sie eine Vollbildaufnahme mit den Standardeinstellungen von Camtasia Recorder.
Mit den Standardeinstellungen in Camtasia Recorder wird eine Aufnahmedatei mit hoher Auflésung
erzeugt, die SmartFocus-Zoom- und -Schwenk-Keyframes enthélt. Diese Keyframes optimieren
automatisch die Darstellung bei der Wiedergabe, wenn fir kleinere Abmessungen, wie z. B. einen
iPod, produziert wird.

46. Kontrollieren Sie lhre Mausbewegungen, indem Sie den Cursor langsam Uber den Bildschirm
fuhren.
Vermeiden Sie es, durch ruckartige oder Kreisbewegungen auf einen bestimmten Bildschirmbereich
hinzuweisen, da dies fur die Zuschauer sehr irritierend sein kann und nur ablenkt. Es ist besser, nach
der Aufnahme mithilfe von Camtasia Editor den Cursor zu verbessern. Sie kdnnen Markierungen,
Animationen und mehr hinzufigen.

47. Sie brauchen nicht von vorne beginnen, wenn Sie einen Fehler machen.
Wenn Sie einen Fehler machen, indem Sie auf die falsche Schaltflache klicken oder beim Sprechen
Uber ein Wort stolpern, — brechen Sie nicht ab und beginnen von Neuem. Héren Sie einfach 3 bis 5
Sekunden auf zu sprechen, und beginnen Sie wieder da, wo Sie aufgehoért haben. Schneiden Sie
dann mithilfe von Camtasia Editor den Abschnitt heraus, in dem der Fehler aufgetreten ist. Die Stille
auf der Timeline zeigt Ihnen, wo sich die Fehler befinden.

48. Wenn Sie Text anzeigen, stellen Sie sicher, dass die Schrift gut lesbar ist.
Verwenden Sie eine SchriftgroRe, die groRer ist als die, die Sie Ihrer Meinung nach brauchen. Dies
gilt insbesondere bei der Aufnahme einer PowerPoint-Préasentation.

49. Machen Sie mehrere kurze Aufnahmen statt einer langen.
Ist Ihr Video langer als 5 Minuten, teilen Sie es auf in mehrere separate Videos.

Der Einsatz von Spezialeffekten

50. Setzen Sie Effekte sparsam ein.
Nur weil Sie Glockenlauten und Pfeifen einfiigen kénnen, bedeutet dies noch lange nicht, dass es
ratsam ist. Ein durchdachtes, professionelles Video verwendet Effekte nur, wenn nétig, etwa um die
Aussage des Videos zu bekréftigen oder es sonst zu verbessern.

51. Verwenden Sie pro Video nur eine Art von Ubergangseffekt.
Mehrere Arten von Ubergangseffekten werden von den Zuschauern nur als Ablenkung empfunden.
Ein optisch und zeitlich gut platzierter Ubergang wird gar nicht bemerkt.

52. Verwenden Sie &hnliche Callout-Formate, -Farben, -Gro3en, usw.
Die Verwendung vieler unterschiedlicher Callouts in verschiedenen Farben kann vom Betrachter als
Ablenkung empfunden werden und kann zur Folge haben, dass das Video unprofessionell wirkt.
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53. Schneiden Sie lange, stille Momente heraus, in denen Sie tippen, Formulare ausfullen oder auf
den Start einer Anwendung warten.
Verwenden Sie stattdessen einen Ubergangseffekt in Camtasia Editor, um das Verstreichen von Zeit
anzudeuten: Schneiden Sie den Abschnitt heraus, in dem keine Aktion stattfindet, und behalten Sie
nur den Anfang und das Ende bei, wo noch etwas passiert. Nehmen Sie dann auf der Timeline eine
Teilung zwischen dem Anfang und dem Ende vor, und fiigen Sie den Ubergangseffekt Schwarz
ausblenden oder Drehender Wiurfel ein.

Camtasia Studio Gruppenprojekte

Bearbeiten

54. Uben die Anwendung von Camtasia Editor mithilfe des Beispielvideoprojekts , Getting Started*.
Zum Lieferumfang von Camtasia Editor gehort ein Beispielprojekt. Verwenden Sie dieses Projekt, um
grundlegende Bearbeitungsvorgange wie Ausschneiden, Kopieren, Einflgen, Teilen, Rickgangig
machen und Wiederholen durchzufthren.

55. Lernen Sie, wie der Schieberegler funktioniert.
Der Schieberegler dient dazu, auf der Timeline eine Auswahl vorzunehmen.

# Ziehen Sie den grinen Anfangspunkt oder den roten Endpunkt, um eine Auswahl|
vorzunehmen.

# Doppelklicken Sie auf den grauen Schieberegler, um die Punkte wieder zusammenzufuhren.

56. Wenn Sie die Audiodaten erhalten, aber die Videodaten ausschneiden méchten,
trennen Sie die Verknupfung zwischen der Video- und der Audiospur.
Wenn Sie Anderungen vornehmen miissen, bei denen Sie Teile des Videos ausschneiden miissen,
die Audiodaten aber erhalten bleiben sollen, trennen Sie die Verknipfung zwischen der Video- und
der Audiospur. Anschliel3end sperren Sie die Audiospur. Auf diese Weise verlieren Sie keine Teile
des Kommentars, wenn Sie Schnitte vornehmen.

Spuren ¥

Klicken Sie auf den
blauen Punkt, um die
Video- und Audiospuren j

ZU trennen.

57. Fuhren Sie die Bearbeitung mit Abmessungen durch (in Camtasia Editor
Bearbeitungsabmessungen genannt), die den Abmessungen entsprechen, die die Zuschauer
im Abschlussvideo sehen werden.
Wenn Ihr Video also fiur die Veroffentlichung auf iPods bestimmt ist, wahlen Sie fiir die Bearbeitung
die iPod-Abmessungen.

58. Nehmen Sie alle Anderungen in dem Video vor, und fiigen Sie dann die Callouts, Titelclips,
usw. hinzu.

Weitergabe des Videos

59. Bevor Sie lhr Video weitergeben kénnen, missen Sie es produzieren.
Wenn Sie mit Camtasia Editor an lhrem Video arbeiten, arbeiten Sie in einem Videoprojekt
(CAMPROJ genannt). Um ein Video zu erstellen, das Sie anderen zeigen kénnen, klicken Sie oben
im Fenster auf die Schaltflache Produzieren und weitergeben.

60. Schauen Sie |hr Video von Anfang bis Ende an, bevor Sie es vertffentlichen.
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